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SAFETY INSTRUCTIONS

1. Depressurize and vent system prior to installation or removal.

2. Confirm chemical compatibility before use. ‘\fﬁ{,’/ ,
3. Do not exceed maximum temperature/pressure specifications. 1\ Q;yw,/{,’}i J//
4. Wear safety goggles or faceshield during installation/service. %“g P
5. Do not alter product construction. =

1.0 Description

The 2551 Magmeter measures the flow rate in a full pipe by monitoring the voltage produced when the (conductive) fluid moves through

a magnetic field.

Output options include a traditional frequency signal, a serial data (digital) output, and a 4-20 mA output.
The 2551 Magmeter is available in three sizes that will accommodate pipes from %% inch through 12 inch diameters.
Select from four different material combinations to match the magmeter to the application requirements.
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WARNING! Ny
=

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY RESULT
IN THE SENSOR BEING EJECTED FROM THE PIPE!

. DO NOT USE ANY TOOLS ON THE RETAINING CAP.
HAND TIGHTEN ONLY.

. THE O-RINGS CAN BE LIGHTLY LUBRICATED TO
FACILITATE INSERTION INTO THE PIPE FITTING. DO
NOT USE PETROLEUM-BASED LUBRICANTS!

. DO NOT USE THREAD SEALANT OR LUBRICANTS ON
THE RETAINING CAP OR ON THE PLASTIC FITTING
THREADS.

. IF LEAKING IS OBSERVED FROM THE RETAINING CAP,

TIGHTENING.

[ |
1 o i

Do not use any tools to

DO NOT USE thread sealant or
lubricants on retaining cap!

tighten the yellow retaining cap.

The O-rings can be lightly
lubricated to facilitate insertion
into the pipe fitting.

DO NOT USE petroleum-based
lubricants on O-rings!

<—— DO NOT USE thread sealant

- or lubricants on the fitting

IT INDICATES DEFECTIVE OR WORN O-RINGS ON THE SENSOR. DO NOT ATTEMPT TO CORRECT BY FURTHER




2.0 Specifications

Wetted Materials:
»  Sensor body and Electrodes and Grounding ring:

« -PO, -P1, -P2: Polypropylene and 316L SS
« -TO,-T1, -T2: PVDF and Titanium
+ -VO, -V1,-V2: PVDF and Hastelloy-C
+ -WO0,-W1,-W2: PVDF and 316L SS
e O-rings: FPM (standard)
EPDM, Kalrez® (optional)
The user is responsible for determining the chemical
suitability of these materials for a specific application.
* Case: PBT
» Display window: Polyamide

Power Requirements
e 4t020 mA: 21.6 t0 26.4 VDC, 22.1 mA max.
400 mV p-p maximum ripple voltage
«  Frequency: 510 26.4 VDC, 15 mA max.
» Digital: 510 6.5 VDC, 15 mA max.
»  Auxiliary (only required for units with relays):

9 to 24 VDC, 0.4A max

*  Reverse polarity and short circuit protected

Performance

*  Pipe size range:

*  Flow Range
(Bi-directional)

* Linearity:

*  Repeatability

*  Minimum Conductivity:

DN15 to DN300 (2 to 12 in.)
Minimum: 0.05 m/s (0.15 ft/s)
Maximum: 10 m/s (33 ft/s)

+1% of reading +0.01m/s (0.033 ft/s)
+0.5% of reading @ 25°C (77°F)

20 uS/cm

Output Specifications
Current output (4 to 20 mA)
*  Max Loop Resistance:

*  Loop Accuracy: 32 pyA max. error (25°C @ 24 VDC)
e Temp. drift: +1 pA per °C max.

= Power supply rejection: 1 pAperV

» Isolation: Low voltage <48 VAC/DC

from electrodes and aux power
300 m (1000 ft.)

22.1 mA

300Q

¢ Maximum cable:
. Error condition:

Frequency output:

e Output modes: Freq, Freq+10, or Mirror Relay 1
*  Max. Pullup Voltage: 30 vDC

* Reverse Polarity Protected to -40 V

Relay Specifications
* Relay 1 and 2 Type: Mechanical SPDT
Rating: 5A @ 30 VDC max., 5A @ 250 VAC max.
* Relay 3 Type: Solid State
Rating: 50 mA @ 30 VDC, 50 mA @ 42 VAC
Hysteresis: Adjustable, plus timer delay
Trigger Delay:  Adjustable (0 to 9999.9 sec.)

Relay Modes: Off, Low, High, Window, and Proportional Pulse
Relay Source: Flow Rate, Resettable Totalizer
Error Condition: Selectable; Fail Open or Fail Closed

Display
Characters: 2x16
Contrast: User-set in four levels

Backlighting (only on relay versions):
Requires external 9-24 VDC, 0.4 mA max.

Environmental Requirements
Storage Temperature:

-20° to 70°C (-4° to 158°F)
Relative Humidity :

0 to 95% (non-condensing)
Operating Temperature
*  Ambient: -10° to 70°C (14° to 158°F)
*  Media: 0° to 85°C (32° to 185°F)
Max. operating pressure:
10.3 bar @ 25°C (150 psi @ 77°F)
1.4 bar @ 85°C (20 psi @ 185°F)

bar psi 2551
I Pressure vs. Temperature
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°c— -18 4 27 49 71 93 115
Media Temperature

+  Max. Current Sink: 50 mA, current limited Dimensions
*  Maximum cable: 300 m (1000 ft.) e 95.3mm __.|
(3.751in.)
Digital (S°L) Output:
- Serial ASCII, TTL level 9600 bps C
*  Compatible with Signet 8900
Standards and Approvals
© CE s
.6 1n.
e UL, CUL (for display versions with relays)
.« NEMA4X/ IP65 Enclosure (with cap installed) v Vo
«  EMC: EN55011: 1998 +A1:99+A2:02 A
Class B Emissions X0 =
ENG1326: 1997 +A1:98+A2:01 o
EN61000-6-2:2001 Y
«  Safety: EN61010-1:2001 Pipe Range
+ U.S. Patent No. 7,055,396 B1 1/2to 4in. -X0= 58 mm (2.3in.)
5to8in.  -X1=91mm(3.6in.)
10to 12in. -X2= 167 mm (6.6in.)
X =Sensor Body P, T, V,or W
2 +GF+ 2551 Magmeter



3. Installation: Pipe fittings

Georg Fischer offers a wide selection of installation fittings that control the position of the Magmeter electrodes in relation to the

dimensions of the pipe. You will find a complete list of order numbers for installation fittings in the Calibration Tables on pages 12-13.

Type Description Type Description
Plastic tees e 0.5 to 4 inch versions Iron, Carbon Steel, ® 0.5to 2in. versions )
e PVC or CPVC 316 SS Threaded * Mounts on threaded pipe ends
tees
PVC e Available in 10 and 12 inch sizes only Carbon steel & ® 2to 4 inch, cut 1-7/16 inch hole in pipe
Glue-on e Cut 2-1/2 inch hole in pipe stainless steel ® OQver 4 inch, cut 2-1/8 inch hole in pipe
Saddles e Weld in place using solvent cement Weld-on i
Weldolets
PVC ® 2to 4 inch, cut 1-7/16 inch hole in pipe
Saddles e 6 to 8 inch, cut 2-1/8 inch hole in pipe Fiberglass e 1.5in. to 8 in. PVDF insert
tees & e >8in. PVC insert
saddles:
FPT
® Available in 10 and 12 inch sizes only FPS
Clamp on e Cut 2-1/8 inch hole in pipe Metric ® For pipes from DN 15 to 50 mm
Saddles Union ® PP or PVDF
tees
Iron = ® 2to 4 inch, cut 1-7/16 inch hole in pipe
Strap-on ‘(/\Y e Over 4 inch, cut 2-1/8 inch hole in pipe
saddles \/

3.1 Installation: Selecting a Location
*  The 2551 requires a full pipe and a fully developed turbulent flow profile for accurate
measurement.
«  If the piping system harbors air pockets or bubbles, take steps to locate the sensor so
the air pockets will not contact the electrodes.
. In vertical installations, assemble the 2551 so the conduit ports are facing downward.

This prevents condensation inside the conduit from being directed into the 2551

electronics housing.
*  Chemical injection systems can temporarily alter the fluid conductivity and cause
anomalies in the magmeter measurement.
To avoid this problem, install the magmeter UPSTREAM of the injection point.

Select a location with sufficient
distance of straight pipe immediately

upstream of the sensor.

Inlet Outlet
Flange Reducer 90° Elbow
— Y ———— | (A—=> '
10x1.. 5x1.D. 15x 1.D. 5x1.D. g 20x1.D. 5x1D.
2 x90° Elbow
2 x 90° Elbow 3 dimensions Valve/Pump
X
] [r—

l

&
7@ 25x1.D.

Gl —>
40x1.D.

] —>
5x1D. 50x ..

5x1.D.

Locating the sensor in a trap or where the
flow is upward helps to protect the sensor
from exposure to air bubbles when the
system is in operation.

Bl %o

Vertical flow is OK IF the pipe remains full at all times.

These configurations are not
recommended because it is difficult to

keep the pipe full.

b

In a gravity-flow system, the tank must be
designed so the level does not drop below the

outlet.

This causes the pipe to draw air in from the tank.
If air bubbles pass across the Magmeter
electrodes, the output will become erratic.

2551 Magmeter
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4.0 Overview of 2551 Display Magmeter

2551 Display Magmeters use a dual-sided electronics module and dual conduit ports. Unused ports must be sealed to protect the

electronics from water damage.

The lower set of conduit ports provide access to the wiring terminals for:
* Loop Power
* Flow Output Signal (current loop, frequency or Mirror Relay 1 output).

@ The upper set of conduit ports provide access to the wiring terminals for:
* Relay output wiring
* Auxiliary power for relay coils and display backlight

@The sensor is marked with a directional arrow to indicate the direction identified as forward flow.
An adhesive decal is also provided that can be affixed to the pipe to indicate the direction of forward flow.
Flow in the opposite direction from the arrow will be identified as reverse flow on the display by a "-" symbol.

The terminals in the magmeter are designed to accomodate 16 to 22 AWG conductors.
@ The display includes two LEDs that light when Relay 1 or Relay 2 are activated.

« All three relays can be monitored by scrolling to the Relay Status display located in the View menu.
« If the Language option has not been made, new magmeters will always open with the Select Language display.

Language
English >

The part number, serial number and output type are identified on the electronics module.

RELAY 1 (@

420 GPM
123456.78 >

Signet Magmeter

®) RELAY 2

—>
®

A ¥V > eNmERr
°

| Aux Pwr]|_Relay3 || Relay 2 JLRelay 1|

Relay output
Aux power

—
®

4-20 mA output
Digital output
Frequency output
Mirror relay 1 output

< ® >

-

4-20/freq out

s/n 60504201234
60504201234

pin 3-2551-11
3-2551-11 @

+GF+

2551 Magmeter



5.0 Wiring

5.1 Basic Wiring

Frequency output

5 Aucxiliary Power for:
I Display bgcklighting V-
- Relay Coils

3-2551-21 and 3-2551-41 Magmeters may be programmed
to provide an open collector FREQUENCY output.

The maximum frequency output is 1000 Hz (@ 10 meters per
second)

If the Frequency + 10 output is selected, the maximum
frequency is 100 Hz (@ 10 meters per second)

AUX PWR must be connected to power the display
backlighting and to power the relay coils if included.

NO1 Y
Nc1 8
ci @
Noz2 O
Nc2 [
c2 3

Nos

N[ex] = |

| Aux Pwr||| Relay3 || Relay 2 Il Relay 1 |

I |
+
4.5-26.4

VvDC

Ground

= -VDC

Signal

=+ \/DC  m—
Frequency Out —

Frequency + 10 Out
(5 to0 26.4 VDC)

2551 Magmeter

Digital (S°L) Out
(4.5 t0 6.5 VDC)

4-20 mA output
The 3-2551-22 and 3-2551-42 Magmeters provide a passive 4-20
mA loop output.

External loop power (24 VDC) is required.

Factory standard calibration is 4 - 20 mA =0 -5 m/s.

The 4-20 mA output can be spanned to any range, from -10
m/s to +10 m/s.

AUX PWR must be connected to power the display
backlighting and to power to the relay coils if included.

NOTEE
N(e3N = |
ctl@l ¢
no2 B
N2l 3
[}
cc@
No3 [ N
nesd &
[0
c3 g | =
= — — — — — — —
Auxiliary Power for: V+ s
| - Display backlighting V- %’ I
—RelayGails _ _ _ _"_ e I

A
O
o S Ay AR
Sz || 4-20 mA Loop Output = @',
I8 |+ O 4, | +vDC

2551 Magmeter

2551 Magmeter

5.2 Wiring: Mirror Relay 1 output

The 3-2551-21 and -41 Magmeter can be configured to provide
an Open Collector output in lieu of the sensor signal provided
by Frequency or Digital output selections. The Open Collector
Output can be programmed via the Relay 1 menu.

2551 Magmeter
|

Not used
Ground

Open Collector Out —»

<— 5-24 VDC

N

5.3 2551 and other manufacturer's instruments

When using the 2551 in a system with other manufacturer's
equipment, a pull-up resistor may be required to power the open
collector output.

r
Non-Signet Flow Instrument

+GF+

Auxiliary Power for:
* Display backlighting
- Relay Coils

—————— 1
|

I
24 VDC

Ground @

ensr Gnd
(SHIELD)
Sensr IN
(RED)

Frequency Input

524vDCOut @ Frequency Out

/I/ 5-24 VDC
10 KQ

Pull-up Resistol



5.4 Wiring to Signet Flow Instruments

2551 and 8900 Multi-Parameter Controller: Frequency Out 2551 and 8900 Multi-Parameter Controller: Digital Out
——————— = |- - - - - - -
n | | |
3 I | I
= | Auxiliary Power for: | Auxiliary Power for:
& - Display backlighting | + Display backlighting
z | - Relay Coils | | - Relay Coils
1/0 Module 3-8900.401-X - Fae00.6210 m: 1 . 1/0 Module 3-8900.401-X Shs006210 |
‘, T
Frequency +5VDC (Black ) (L] Z 'L:’ [ +5VDC (Black) ) L[] |
mput  Freq. Input (Red , e oo '"’1’”‘ Freq. Input (Red) [T |
) o _ e —
GND (shield) i [(Te— e ] GND (Shield) [ /Il
a 4
Froauency  +5VDC (Black)| || " [ [ 3] +| g Froqueney  +5VDC (Black)| || * [T] ' 9
'"Z‘;z Freq. Input 2 (Red (11 - = L M2 '"‘(’)‘:2 Freq. Input 2 (Red) (11 >
<
B S3L (Red)| || ° (T i s S3L (Red)| || ° [LIT) N
N . 7 Inpu
2" GND (White/Shield) (11 2" GND (White/Shield)| || * [T 11
+5VDC (Black) || * [[1 1] [ Ground ! +5VDC (Black) || ° (1]
s3L 3 * T | s3L 9
gt S3L (Red) Frequency Out gt S3L (Red)
GND (White/ShieId) | — 524v0c — | GND (Whlte/ShleId) T
1 1
Analog Output 1 » [T ! Analog Output 1 [0
(if applicable) D:H | (if applicable) 12 D:H
13 m 2551 Magmeter 13 m
Analog Output 2 = ! - - - - -~ Analog Output 2
(if applicable) 11 (if applicable) “I 11

2551 and ProcessPro 8550 Flow Transmitter
When connecting the 2551 to any 8550 model, the AUXILIARY power in the 8550 must always be connected.

Std. Sensor.
Open Collector
10w Sensor

| |
V+ 2 ﬁ |
I x
I V- i +
- e = S —A 24 VDC
I 8550-1 Flow Transmitter ® | _
12- 24 VDC |
| Power Source |
| «TEQ 4 | Bgogem P |
ﬁ — | —1 = }—
| | 3 fgg}?’f Pur |E O Output - |E Gre (Sseﬁfé_%}d Ground
I_= = |— = = [— I
I Bel2 & [o (0] e e —eround= |
| D @ 1 e |H O] 5 | output+ m Ol 7 (SBeCEE:X; Frequency Out I
| Open Collector — 5-24VDC — I
I Output Sensor Input
Terminals 3-4: 4-20 Loop, Loop Power from |
| Terminals 1-2: Auxiliary Power Magmeter
2551 Magmeter |
[ = — — — — — — — — — — — — — — — — — — — — — — — ow— w— — —
2551 and ProPoint 5075, 5500, 5600 |- - - ——-— -
NOTHR ] |
I Net o : I
I @ €]
| no2OF I
| Ne2D & |
c2 n:_ |
I Nos@ @ .,
® R
[INex] = - R
cag ¢ Lol
ARI“EF Power for:  V/+ —g_ -
Display backlighting x
| Ry v BT +
I — 24 VDC
| ‘s -
_______________ H
| Signet 5075, 5500, 5600 ; - P 4 | Ground I
| I ; .S——Ground I
|
| fE@ o000 | | 2 | Frequency Out
| m | | @ 524vDC J
o EEEEEEEEEEEE | | '
I HHEHE I I 2551 Ma I
s|g ] gmeter A
1 || |8 . T T T T 0=
o
| |
| ]

6 +GF+ 2551 Magmeter



5.5 Wiring Relays

Relay 1, Relay 2 Type: Mechanical SPDT

Rating: 5A @ 30 VDC max., 5 A @ 250 VAC max NO1
Relays 1 and 2 are dry contact relays rated for 5 A maximum current. 1
Relays 1 and 2 are best suited for switching high voltage loads, such as AC NC
powered pumps and valves. C1
When used to switch inductive loads, dry contact relays may be damaged by
arcing. Signet recommends the installation of a filter device to prevent such NO2
damage.
d NC2
3-8050.396 159 000 617 RC Filter kit (for relay use) c2
NO3
Relay 3 Type: Solid State NC3
Rating: 50 mA @ 30 VDC, 50 mA @ 42 VAC
Relay 3 is a solid state relay. It can be applied exactly the same as a dry C3
contact relay, but the current rating is 0.2 A (200 mA) maximum. Relay 3 is
best suited to pulse applications and low voltage loads. V+
V-

OoOoooooooooo

A\

Auxiliary power must be connected to operate the relays and to
power the display backlighting. Auxiliary power is fully isolated.
The Loop Power supply may be used for Aux power if the power

source provides a sufficient current rating.

| | Relay 3 | | Relay 2 | | Relay 1

Mechanical Relays:
5A @ 250 VAC
5A @ 30 VDC

Solid State Relay 3:
50 mA max @ 30 VDC
50 mA max @ 42 VAC

Auxiliary Power
9to 24 VDC
0.4 A Maximum

Relay Terminal Legend:
NO: Normally Open

NC: Normally Closed

C: Common

Application Notes: Relay Wiring

* Inductive relay loads may generate transient voltage spikes well in excess of the relay contact ratings. This will cause arcing
across the contacts and consequently rapid relay wear. Signet recommends a RC-style filter (“snubber”), installed as illustrated

here.

»  The filter kit (3-8050.396) is available as an accessory item. See ordering information on back cover.
»  Signet product warranty does not cover damage to relays due to contact burnout.

3-8050.396

arcing across mechanical switching contacts or can cause
damage to solid-state contacts.

2551 Magmeter +GF+

AC-powered: NO1
Pumps
Alarm lamps NC1
Audio alarms
Mixers 120-240 VAC pr— C
NO2
NC2
Cc2
Definition: NO3
An inductive load is an electrical device generally made of wire
that is coiled to create a magnetic field to produce mechanical NC3
work when energized. Cc3
Examples of inductive loads include motors, solenoids, and
relays. V+
High voltage transients from these types of loads can cause V-

OoOoooooooooo

Mechanical Relays:
5A @ 250 VAC
5A @ 30 VDC

Solid State Relay 3:
50 mA max @ 30 VDC
50 mA max @ 42 VAC

| | Relay3 | | Relay 2 | | Relay 1

Auxiliary Power
9to 24 VDC
0.4 A Maximum




6.0 View Menu
The VIEW menu contains all of the basic information available from the magmeter.

*  The normal operating display shows the FLOW RATE on the top line of the display
and the Resetable Totalizer on the lower line of the display.

| - . +GF+
*  The Right Prompt symbol (>) always indicates a sub-menu associated with the current
display. In this display it points the way to the TOTALIZER RESET function. See RELAY 1 @ @® RELAY2

section 6.1 for detailed instructions.
1234.56 GPM
876543.21 >

Signet Magmeter

+  With AUXILIARY power connected to the magmeters with Relays, the display will be
backlit. There is no switch to turn the backlight off.

. aAﬂashing character or text on the display indicates that the item is being edited.
This manual uses a (red) star to illustrate a flashing display. A Y > enERr

e o e o
»  The following information is viewed by scrolling UP or DOWN. These displays will
remain in the display for 10 minutes, then the normal operating display will return.

()
vV A
Show the permanent total. This totalizer cannot be Gallons
reset. Perm 876543.21
\Y A
Shows the current output. For 4-20 mA Output models Current Output
only. 14.89 mA
v A
Relay States shown for units with a relay board. Relay 1 2 3
Off Off  Off
o . N . v A
This display is a reminder to visit the Signet website for -
dates and information about Signet product Web Site
updates and information about Signet products. www.gfsignet.com
\% A
Enter menus from this display. See section 6.2. Enter Menu
>

6.1 Resetting the Resetable Totalizer

+GF+

RELAY 1 @ @ RELAY2

1234.56 GPM
876543.21 >

Signet Magmeter

A YV » mamr
o o o

([ ]
1234.56 GPM 1. From the normal operating display, press the RIGHT arrow key.
876543.21 >
2. The resetable totalizer can be configured to require the security code before allowing the
Entgr Code reset. If the Total Reset set to "RESET OFF" this display will not appear.
,Q‘ 0 See section 11, Options Menu for instructions.
Reset Total, ? 3. Press any arrow key to toggle the flashing selection from NO to YES.
Yes
123456.78 GPM 4. Press the ENTER key. The totalizer will reset to 000000.00 and the display will immediately
000600 00 > return to the normal operating display.

8 +GF+ 2551 Magmeter



6.2 Navigating the Menus

Normal Operation Display

The normal operating display shows the Flow Rate on the top line and the Resetable RELY 1 @ )RR

Totalizer on the bottom line.

* Al menu instructions in this manual assume that the instrument is showing this

display.

+GF+

1234.56 GPM
876543.21 >

Signet Magmeter

2551 Menu Directory

The 2551 magmeter uses seven main menus to provide access to the calibration and
programming features. Each menu serves a specific function.

A V¥V P R
® ® @ ®

[}
Starting from the normal operating display, there are two ways to access the menus: A ENTER
1. Press the UP arrow key to scroll to the Enter Menu display, then press the RIGHT Enter Menu
arrow key. > Q
2. Press the ENTER key and hold it for about three seconds. > 3s
Setup Menu Enter Menu
This menu contains all of the settings and information that the magmeter requires to Setup z
operate, including the K-factor, the totalizer settings, low flow cutoff, and several display \Y, A
Enter Men
Calibration Menu Calibrationu 5
The Calibration menu provides two different methods for adjusting the calibration. See
section 8.0 for details related to this menu. \Y A
Enter Menu
>
Relay Menus Relayal
Each of the available relays in the 2551-21 and -22 are programmed from their own \Y A
dedicated menu. See section 9 for details related to these menus. Enter Menu
Note: Menu items associated with Relay 2 and relay 3 are suppressed in models without Relay 2 S
relays. See section 9.0 for details related to this menu.
\ A
Enter Menu
Relay 3 >
Test Menu V A
The Test menu is used to manually toggle relays or to induce a known value out of the Enter Menu
4-20 mA terminals. See section 10.0 for details related to this menu. Test >
v A
Options Menu Enter Menu
The Options menu contains those settings and values that are usually programmed during Options >

the initial installation, and then seldom modified, including the SECURITY CODE (see

section 6.4). See section 11.0 for details related to the Options menu.

6.3 Keypad Functions

A Scrolls UP through any menu.

If the display shows any flashing character or selection,

scrolls UP to the previous value or selection.

If the display shows any flashing character or selection,

v Scrolls DOWN through any menu.

scrolls DOWN to the next value or selection.

AV Press the UP and DOWN keys together to abandon any

unsaved edits and return to the previous display.

I> Opens the menu currently being displayed.
In Edit modes, advances the flashing character.

In menus with only two options (Yes or No, On or Off)

toggles between selections.

6.4 Security Code

The 2551 has a security code that can be programmed to any
four digit numerical value.

The factory setting is 0-0-0-0.

To program the security code go to the Options menu.

The security code will be required to edit any of the items in
the menus. It is required only once for each editing session.
Record the custom security code here or in a safe location.
If the security code is lost, contact your Signet service center

for instructions.
Enter Code
0000

\4

ENTER Saves a new selection in any menu.

From Normal Operation display, jumps to first selection

in Menu directory (when held for three seconds)

2551 Magmeter

A Security Code

+GF+

WRITE IT DOWN!




7.0 Setup Menu

The Setup menu contains all of the parameters necessary for the 2551 Magmeter to begin '|'GF'|'
measuring flow. R ~ EEE
NOTE: The Security Code must be entered before any changes can be made to the Setup menu. Enter Menu

See the Options menu in section 11 for details. Setup

Signet Magmeter

Enter Code A
0000 A YV » enmEr
e @ o (@

A4

Use the keypad to navigate through each setting.

A V > ENTER The values shown for each menu item represent the factory
standard setting. All 2551 magmeters are packaged with these

O O O O settings.

K-Factor: See the charts in section 7.3 for values in pulses per U.S. Gallon or in pulses per

Liter. To use other units, convert the published values as appropriate. K-Factor
060.000 >
Pipe Size: Select the pipe size that is nearest to the nominal pipe size. Pipe Size
2” DN50 >

Flow Units: Set the units for the application. Four characters are available. The first three characters can be set to any symbol or
alpha character, upper or lower case. The following special symbols are located between the upper case and lower case menus:

* (centered dot) M (micro) _ (blank)
- (dash / (slash 3 (for cubic units

( ) ( ) ( ) Flow Units
The last character selects the timebase for the flow rate measurement. GPM >
Select S/s (seconds) M/m (minutes), H/h (hours) or D/d (days)
Set 4 mA: In the 2551-22 and 2551-42 versions only, set the flow rate where the current Set4 mA
output will be 4 mA. etam

-100 GPM >

Set 20 mA: In the 2551-22 and 2551-42 versions only, set the flow rate where the current
output will be 20 mA. Set 20 mA
100.00 GPM >

The 4-20 mA output may be spanned to monitor forward and reverse flow rates.

Total Factor: Set the factor by which the totalizer will count. This setting is made in the Total Factor
application units (ie; gallons, liters, etc..) 1000.0 >
Totalizer Units: Set the Totalizer Units. This setting serves as a label for the totalizer displays Totalizer Units

only. It has no effect on the measurement. The special characters listed in the Total Factor Gallons S
settings are available here also.

Low Flow Cutoff: Set a flow rate that the 2551 Magmeter will use as a minimum threshhold. Low Flow Cutoff

If the flow rate falls below this value, the 2551 will respond as if the flow were zero. 0.5 GPM >
Averaging: Set the averaging period based on the installation and flow conditions. Smaller Averaging

values allow the 2551 to respond to changes in flow rate quickly, while larger values smooth 25 secs -
the fluctuations caused by installation and flow conditions. See section 7.1 for details.

Sensitivity: Set a percentage of maximum range by which the flow must change to override Sensitivity

the averaging feature and "jump" quickly to the new flow rate. See detailed explanation in 100% S
section 7.1.

10 +GF+ 2551 Magmeter



7.1 Averaging and Sensitivity

Even the most carefully engineered flow systems may experience
erratic and unstable conditions. If the instability is communicated
to the output functions, the results may create problems for
control devices.

To alleviate these issues, the 2551 provides two adjustments that
operate in tandem. The information here will help in determining
the appropriate settings for any specific application.

Averaging

*  The AVERAGING setting dictates the time over which the
magmeter will average the flow signal.

The LCD display is updated every second. With averaging at

14 seconds, the flow rate on the display is an average of the
previous 14 seconds input.

Short averaging times provide the fastest display and output
response to changes in the flow rate.
Higher averaging times help to smooth the display and

current output where the flow in the pipe is erratic or unstable

due to installation limitations.

Sensitivity

*  The SENSITIVITY setting determines how the 2551
responds to sudden surges in the flow rate. It "overrides”
the Averaging function just long enough to allow an actual
change in flow rate to be displayed, then resumes the
averaging. The result is a smooth flow display and a quick
response to large shifts in the flow rate.

The settings for Sensitivity represent a percentage of the

magmeter's maximum range, or 10 m/s.
Example: A sensitivity setting of 25% means that the flow

rate must change instantly and by more than 2.5 m/s before

the function is enabled.

NOTE: The SENSITIVITY function is ineffective if the Averaging

function is set to zero.

CAUTION
The SENSITIVITY function changes the response
characteristics of the magmeter. If used as part of a

undesirable.

No Averaging
With AVERAGING set to zero, the flow rate will be displayed

immediately and with no filtering. This line represents the
actual output of the flow sensor as it responds to unstable flow

conditions in the pipe.

A a L
Hnop o8 ook [}
I AN R | b A
S agnay ol e g1t “n ey CET e,
E iy vy II"o.,‘.:,-‘,:, O TR .
X
Lt
e
-‘:‘: \
2 “u
6 l"l
k) ~
g H
'
A
oy
'
'
'
o
L
[
h
'
Time 10s  20s  30s  40s  50s  60s  70s

Averaging Only

With AVERAGING set to 50 seconds and SENSITIVITY still set to
zero the flow rate is stabilized, but a sharp change in flow rate is
not represented on the display or at the output for 50 seconds or

longer.

Velocity

‘‘‘‘‘‘‘‘‘

Averaging and Sensitivity
With AVERAGING at 50 seconds and SENSITIVITY set to
25%, the flow rate is stabilized, while the sudden shift in flow is

reflected very quickly.

>
=
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>
Time 10s 20s 30s 40s 50s 60s 70s

tuned closed loop control system such a change may be

2551 Magmeter
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7.2

Bi-Directional Flow

The 2551 magmeter is designed to measure bi-directional flow.

The forward flow direction is indicated by the directional arrow molded into the side of the 2551 sensor.
The conduit ports are assembled at the factory to point UPSTREAM. They may be reversed by
disassembling the components of the magmeter and reassembling.

Flow Rate Display:

The "+" sign is suppressed during forward flow.
"-123.45 GPM" during reverse flow.

Totalizer Display:

The totalizer will count during forward flow conditions only.
During reverse flow the totalizer will not increment.

Relay Outputs:

May be set to detect reverse flow: "Low Setpoint at -25 GPM."

4-20 mA output:

May be scaled to span any flow range:
For example: "4 to 20 mA =-100 GPM to +100 GPM"

Frequency output, Frequency =+ 10 output: Reverse flow is processed same as forward flow in the frequency output magmeters.

Digital (S°L) output:

Reverse flow results in 0 flow rate output.

7.3 Calibration Data:  K-factors Carbon Steel Tees and Weld-o-Lets
Stainless Steel Tees and Weld-o-Lets
Galvanized Iron Tees
PIPE SIZE FITTING K-Factor K-Factor
PVC Tees and Saddles (IN.) TYPE Gallons Liters
CARBON STEEL TEES ON SCH 40 PIPE
PIPE SIZE FITTING K-Factor K-Factor Va CS4T005 1572.66 415.50
(IN.) TYPE Gallons Liters ¥, CS4T007 1086.73 287.11
1 CS4T010 582.34 153.86
SCH 80 PVC TEES FOR SCH 80 PVC PIPE 1% CS4T012 377.48 99.73
Y PV8T005 2289.37 604.85 172 CS4T015 267.79 70.75
% PV8T007 1430.41 377.92 2 CS4T020 167.85 44.35
1 PV8T010 876.86 231.67
1% PV8T012 447 .06 118.11 STAINLESS STEEL TEES ON SCH 40 PIPE
1% PV8T015 324.19 85.65 Y CR4T005 1601.26 423.05
2 PV8T020 206.69 54.61 ¥, CR4T007 937.78 247.76
2% PV8T025 131.46 34.73 1 CR4T010 606.18 160.15
3 PV8T030 82.52 21.80 1 CR4T012 279.68 73.89
4 PV8T040 44.78 11.83 1% CR4T015 147.65 39.01
2 CR4T020 111.90 29.56
SCH 80 PVC TEES FOR SCH 80 CPVC PIPE
A CPV8T005 2496.03 659.45 STAINLESS STEEL WELDOLETS ON SCH 40 PIPE
% CPV8T007 1381.48 364.99 22 CR4W025 106.31 28.09
1 CPV8T010 857.98 226.68 3 CR4W030 72.27 19.09
1 CPV8T012 44517 117.61 4 CR4W040 36.84 9.73
1% CPV8T015 325.56 86.01 5 CR4W050 29.28 7.73
6 CR4WO060 20.29 5.36
SCH 80 PVC SADDLES FOR SCH 80 PVC PIPE 8 CR4W080 11.73 3.10
2 PV8S020 193.83 51.21 10 CR4W100 7.45 1.97
2% PV8S025 138.01 36.46 12 CR4W120 5.24 1.39
3 PV8S030 83.89 22.16
4 PV8S040 40.88 10.80 CARBON STEEL WELDOLETS ON SCH 40 PIPE
6 PV8S060 2253 5.95 2% CS4W025 105.70 27.93
8 PV8S080 12.52 3.31 3 CS4W030 70.68 18.67
10 PV8S100 7.94 210 4 CS4W040 36.38 9.61
12 PV8S120 5.71 1.51 5 CS4W050 29.28 7.73
6 CS4W060 20.29 5.36
SCH 80 PVC SADDLES FOR SCH 40 PVC PIPE 8 CS4wW080 11.73 3.10
2 PV8S020 180.01 47.56 10 CS4W100 7.45 1.97
2% PV8S025 123.72 32.69 12 CS4W120 5.24 1.39
3 PV8S030 75.81 20.03
4 PV8S040 41.87 11.06 GALVANIZED IRON TEES ON SCH 40 PIPE
6 PV8S060 19.71 521 1 IR4T010 558.50 147.56
8 PV8S080 11.73 3.10 1 IR4T012 334.45 88.36
10 PV8S100 7.43 1.96 1% IR4TO15 248.97 65.78
12 PV8S120 5.23 1.38 2 IR4T020 146.00 38.57
12 +GF+ 2551 Magmeter



7.3 Calibration Data: K-factors

Iron Saddles
PIPE SIZE FITTING K-Factor
(IN.) TYPE Gallons
SCH 80 IRON SADDLE ON SCH 80 PIPE
Polypropylene True Union Tees and Wafers 31/ :Eggg;g 12‘2122
Polypropylene Clamp-on Saddles 3 2 IR8S030 87 5'3
PVDF True Union Tees ’
PVC True Union Tees 4 IR85040 40.62
5 IR8S050 29.28
PIPE SIZE FITTING K-Factor K-Factor g :Eggggg %ggg
(Metric) TYPE Gallons Liters 10 IR8S100 7 é4
POLYPROPYLENE FITTINGS (DIN/ISO ,BS, ANSI) 1 IR8S120 5
DN15 PPMTO005 2192.73 579.32 :
BEE? ,'Z,'ng% 3257121 fgg?g SCH 80 IRON SADDLE ON SCH 40 PIPE
DN32 PPMTO012 453.46 119.81 ;/ :Eggggg g?i?
DN40 PPMTO015 275.03 72.66 5 IR8S030 7660
DN50 PPMT020 164.17 43.35 ) IR8S040 10,23
POLYPROPYLENE CLAMP-ON SADDLES ON SCH 80 PP PIPE 2 :222828 fggf
10 PPS100 7.94 2.10 o IR8S080 161
12 PPS120 5.71 1.51 '
10 IR8S100 7.36
POLYPROPYLENE CLAMP-ON SADDLES ON SCH 40 PP PIPE 12 IR8S120 518
10 PPS100 7.43 1.96
12 PPS120 5.23 1.38
PVDF FITTINGS (DIN/ISO ,BS, ANSI) Bronze and Copper Tees and Brazolets
DN15 SFMT005 1946.49 514.26
DN20 SFMT007 1158.05 305.96 PIPE SIZE FITTING K-Factor
DN25 SFMT010 749.09 197.91 (IN.) TYPE Gallons
DN32 SFMTO012 439.51 116.12 BRONZE TEES ON SCH 40 PIPE
DN40 SFMT015 248.93 65.77 1 BRATOTO 582.34
DN50 SFMT020 146.85 38.80 17 BR4T012 330.54
1% BR4TO015 254.76
PVC FITTINGS (DIN/ISO ,BS, ANSI) 2 BR4T020 157.36
DN15 PVMTO005 2067.76 546.30
DN20 PVMT007 1136.61 300.29 COPPER TEES FITTING ON COPPER PIPE SCH K
DN25 PVMT010 716.52 189.31 I CUKTO005 2459.19
DN32 PVMT012 446.07 117.85 /a CUKTO007 1108.02
DN40 PVMTO15 278.83 73.67 ! CUKTO10 649.87
DN50 PVMT020 159.36 42.10 17 CUKTO012 422.03
1% CUKTO015 281.43
2 CUKT020 136.02
COPPER TEES FITTING ON COPPER PIPE SCH L
Y CUKT005 2406.30
% CUKT007 1174.77
1 CUKTO010 672.28
1% CUKT012 402.84
1% CUKTO015 294.99
2 CUKT020 149.63
COPPER/BRONZE BRAZOLET ON SCH 40 PIPE
2% BR4B025 117.31
3 BR4B030 78.62
4 BR4B040 4513
5 BR4B050 32.79
6 BR4B060 22.73
8 BR4B080 13.14
10 BR4B100 8.34
12 BR4B120 5.87
2551 Magmeter +GF+

K-Factor
Liters

51.48
37.59
23.13
10.73
7.74
5.89
3.31
2.10
1.49

48.97
33.68
20.24
10.63
7.22
5.21
3.07
1.94
1.37

K=Factor
Liters

153.86
87.33
67.31
41.58

649.72
202.74
171.70
111.50
74.35
35.94

635.75
310.37
177.62
106.43
77.94
39.53

30.99
20.77
11.92
8.66
6.01
3.47
2.20
1.55
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8.0 Calibration Menu

The K-factors published in this manual assume that the flow conditions in the pipe are
ideal. +GF+

Many factors that affect the flow rate are beyond the control of the magmeter; variations in RELAY1 @ ® ReLAYv2

actual pipe dimensions, pipe smoothness, and other flow conditions will contribute to the 1234.56 GPM
total system error. 876543.21 >
Signet Magmeter

Performing a custom calibration with the magmeter in place will adjust the K-factor and

can serve to compensate for installation conditions that may be less than ideal. AN FNTER

Select one of the calibration methods in this menu to achieve the most accurate

measurement possible in a specific application. e
A ENTER
NOTE: The Security Code must be entered Enter Menu (o1
before selecting the calibration method. e Q 3
> ]
Enter Code Enter Menu
0000 Setup >
——
v A
Enter Menu
Calibration >

8.1 Volume method of calibration

Use the volume method of calibration if the fluid passing the magmeter can be measured by a volumetric method (as in a vessel of
known volume, or by weight). It requires the ability to pump a known volume of water past the magmeter, and then input the volume
into the 2551 program. It is most useful for small pipes and lower flow rates.

When performed properly, volumetric calibration is the most accurate method. For best results a five minute test period is
recommended, and the test period should be no less than two minutes.

Press Enter At START, the 2551 begins counting the flow past the sensor.
To Start
Press Enter At STOP, the 2551 stores the total flow accumulated since the START.
To Stop
Enter Volume Enter the VOLUME that has been pumped past the sensor.
000000. GPM
Value must be This error message appears if volume entered or the accumulated flow is zero. Repeat the
more than 0.0 test after checking the system.
K-Factor This message appears if the new K-Factor is less than 0.0001 or greater than 999999.
Out of Range To correct the problem, perform the volumetric flow again, and be certain that the volume
entered is accurate.
K-Factor
45.6789 Using the information from the VOLUME method, the 2551 will recalculate a new K-Factor. Press

ENTER to accept the new value, or use the keypad to adjust the value.

8.2 Rate method of calibration

Use this method if the 2551 Magmeter must be calibrated to match a reference flow meter. This is the method most commonly used by
monitoring agencies, and for large pipes where volumetric calibration is impractical. The accuracy of this calibration method is largely
dependent on the accuracy of the reference meter and the proximity of the reference to the Signet 2551 Magmeter.

The flow rate shown is based on the existing calibration of the 2551.

Set New Flowrate Use the keypad to modify the flow rate to match the reference meter. The 2551 will
45.6789 automatically calculate a new K-cactor based on the new flow rate.
K-Factor This message appears if the new K-Factor is less than 0.0001 or greater than 999999.
Out of Range To correct the problem, reexamine the flow rate and make certain it is accurate.
K-Factor Using the information from the RATE MATCHING method, the 2551 will recalculate a new K-
56.7890 Factor. Press ENTER to accept the new value, or use the keypad to adjust the value.
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9.0 Relay Menus

Magmeter models 3-2551-21 and 3-2551-22 have two dry contact
relays (Relays 1 and 2) and one Solid State relay (Relay 3).

Any of these relays can be set to any of the operating modes
listed below.

The setpoint values for HIGH, LOW and WINDOW modes can be
set to negative values if required.

For example, a LOW alarm might be set to activate if the flow rate
falls below -10 GPM.

Negative values are not available for relays in PULSE or TOTAL
modes.

Off: If a relay is not used, it can be turned Off to prevent

contact wear.

NOTE: The Security Code
must be entered before
modifying the relay menu.

Enter Code
0000

+GF+

RELAY 1 @

1234.56 GPM
876543.21 >

Signet Magmeter

@ RELAY 2

A ¥V > &R
® ® @ ®

[ ]
A ENTER
Enter Menu
10 o),
> S
Enter Menu
Setup >
\ A
Enter Menu
Calibration >
\ A
Enter Menu
Relay 1 >

9.1 Pulse Relay mode

Program a relay to activate for a fixed period, for each volume of
fluid that passes the sensor.

For example, program the relay to pulse once for 100 ms for
every 3 gallons that pass by the sensor.

Relay 1 Mode Relay 1 Volume
Pulse > 0.0000 Gal >
Relay 1 Width
0.1 secs >

Relay Volume: Set the volume of fluid that the 2551 must
measure before activating the relay for one pulse.

Pulse Width: Adjust the length of time the relay will remain
activated. The pulse width setting is dependent on the type of
external equipment being connected to the relay.

9.2 Total Relay mode

Program a relay to activate when the Resetable totalizer reaches a specific value. The maximum setting is 999999.

Application example: A filter must be replaced in a R.O. system every 10000 gallons. The service representative that installs a new
filter sets relay 3 to Total mode, sets the setpoint at 10000 and resets the totalizer to 000000.00. When the totalizer is reset, the relay

will be deactivated and the process begins anew.

Every time the Totalizer reaches 10000, the relay activates and lights a message indicator to remind the operator to contact the service

representative to replace the filter.

Relay 1 Mode
Total >

Relay 1 Set High
000000 >

2551 Magmeter
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9.3 High, Low, or Window Relay modes

Program the relay to activate when the flow rate reaches a setpoint (High or Low) or when the flow

rate moves outside of a prescribed range (Window).

Reverse Flow

The setpoint values for HIGH, LOW and WINDOW modes can be set to negative values if required.

For example, a LOW alarm might be set to activate if the flow rate falls to -10 GPM.

Process

Hysteresis - 4

Low Setpoint -

> Time

Process

High Setpoint -,

Hysteresis == =====f----======-q------*

> Time

Process

Lo LHysteresis

TTTTTTTTTTTTTT ::@'f’" T

> Time

Relay activated
Relay deactivated &

Relay behavior with LOW Setpoint

Relay behavior with HIGH Setpoint

Relay behavior with WINDOW Setpoints

RELAY 1 @

1234.56 GPM
876543.21 >

+GF+

® RELAY2

Signet Magmeter

A Y P> EnTER
o

Enter Menu

[ ]

A ENTER

e,

> S
Enter Menu

Setup >

\ A
Enter Menu
Calibration >

\ A
Enter Menu

Relay 1 >

A

NOTE: The Security
Code must be entered
before modifying the
relay menu.

Enter Code
0000

K‘

The values shown for each menu item represent the factory
standard setting. All 2551 magmeters are packaged with these

settings.

Set Low: Set the flow rate where a Low relay will be activated.

Set High: Set the flow rate where a High relay will be activated.

Hysteresis: Set a flow rate increment where the relay will be
deactivated. The hysteresis setting serves to prevent relay
"chatter" when the flow rate recovers from an alarm condition by
requiring the low rate to move substantially within the setpoint.

Delay: Set a time period for the relay to wait after reaching
the setpoint. This delay serves to prevent the relay "chatter" by
allowing the flow rate time to move back within the setpoint.

16

Relay 1 Mode Relay 1 Set Low
Low > 00.000 GPM >
Relay 1 Hys
00.000 GPM >
Relay 1 Delay
0.1 secs >
Relay 1 Mode Relay 1 Set High
High > 00.000 GPM >
Relay 1 Hys
00.000 GPM >
Relay 1 Delay
0.1 secs >
Relay 1 Mode Relay 1 Set Low
Window > 00.000 GPM >
Relay 1 Set High
00.000 GPM >
Relay 1 Hys
00.000 GPM >
Relay 1 Delay
0.1 secs >

The menu repeats for Relay 2 and Relay 3.

+GF+
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10.0 Test Menu

The Test menu provides a simple method to verify that the system is operating properly. Auxiliary power MUST be connected to the

2551 to activate the relays

+GF+

RELAY1 @ @ RELAY 2

Enter Menu
Test

Signet Magmeter

A A ™ EnNER
(] () (] (]

Test Output
4.20 mA

Test Relay 1
Open Closed

Test Relay 2
Open Closed

Test Relay 3
Open Closed

Shown for 4-20 mA models Only
Use the keypad to enter any current output from 4.0 mA minimum
to 22.1 mA maximum.

Shown for Relay models Only
Toggle any of these relays ON and OFF to verify that the system
is operating properly.

Auxiliary power MUST be
connected to the 2551 to test
the relays.

V+ . Auxiliary Power
9to0 24 VDC
v- 3

0.4 A Maximum

11.0 Options Menu

The Options Menu contains those features and settings that will normally be set one time and then seldom changed. These include
language preference, decimal placement, Security Code assignment, etc.

+GF+

RELAY1 @ ® ReLAY2

Enter Menu
Options

Signet Magmeter

A ¥V P R
() ()

The values shown for each
menu item represent the
factory standard setting.
All 2551 magmeters are

packaged with these settings.

Language
English

Security Code

*kkk

Contrast
2

Total Reset
Lock On

Noise Rejection
60 Hz

Flow Decimal

F*kkk k%

Total Decimal

*hkkkk kk

Separator
ddd.d

Output Mode
Frequency

Select from English, German, French or Spanish.
This Selection will be displayed at first power-up of a new magmeter.

Security Code can be set to any four digit number. Factory standard
setting is 0000.

Set for best view after the magmeter is installed. Larger number
means display appears darker.

Lock ON requires the Security Code before resetting the Resetable
Totalizer. Lock OFF reset with no security code.

Filters out common 50 or 60 Hz electrical noise.

Set the maximum resolution for the FLOW RATE display by limiting
the decimal to this point. The Flow Rate display will auto-scale from
this resolution up to whole units.

Set the maximum resolution for the TOTALIZER display by limiting
the decimal to this point. The Totalizer display will always show this
resolution.

Select decimal point or comma for use in numeric displays.

For Frequency/Digital models only: Select Freq output, Freq + 10
output, Mirror Relay 1 output or S°L Digital output.

11.1 Output Modes

In FREQUENCY output mode, the 2551 serves as a traditional flow sensor and provides an output pulse that is compatible with all
Signet POWERED flow instruments. It is not compatible with the 5090 Self-Powered Flow Meter or the 8150-1 Battery-powered flow

totalizer. The frequency output range is from 0 Hz to 1000 Hz.

The FREQUENCY =+ 10 output mode reduces the output frequency of the 2551 to a range that is useful for some programmable
logic controllers (PLC). The frequency output range is from 0 Hz to 100 Hz. This shift does not affect the stated accuracy of the 2551

Magmeter's frequency output.

The MIRROR RELAY 1 output mode allows 2551 Frequency/Digital models to use the Open Collector Output like a relay that can be

programmed via the Relay 1 menu.

If the magmeter is equipped with relays, this mode will mirror the settings of Relay 1.
If the magmeter is not equipped with relays, this mode can still be selected and programmed via the Relay 1 menu.

The S°L Digital output mode switches the 2551 to the Signet serial data output called S3L (Signet Serial Sensor Link). In this mode the
2551 can be added to the serial bus of the Signet 8900 Multi-Parameter Controller.

2551 Magmeter
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12.0 Technical Information
12.1 Grounding

Precalibration conditioning: The magmeter may appear to be unstable immediately after installation. Allow the sensor to sit in a full
pipe for 24 hours before beginning calibration and operation.

» Use a cable gland or a liquid tight connector to seal the cable ports from water intrusion.

*  Use Teflon tape or a suitable sealant on cable ports.

*  The 2551 magmeter must be carefully grounded to eliminate electrical noise that may interfere with the measurement.

*  Grounding requirements will vary with each installation.

»  The following recommendations should be applied in sequence until the interference is eliminated.

® The ground terminal on the outside of the yellow housing is connected internally to the grounding ring at the tip of the sensor.
Connect a conductor (14 AWG/1.5 mm?wire recommended) from this terminal directly to Earth ground to prevent electrical noise
from interfering with the magmeter signal.

If the interference persists, apply step #2:

@ Connect grounding rings, metal clamps or grounding electrodes to the pipe immediately upstream and downstream of the
magmeter sensor location. These devices must be in contact with the fluid.

If the interference persists, apply step #3:

® The shield from the output cable must be terminated at the remote instrument ONLY.
This shield must not be connected at both ends!

If the interference persists, apply step #4:
@ Connect an additional wire (minimum AWG 14/1.5 mm?) from the remote instrument ground to the magmeter ground terminal.

[ 1
O O

Do not terminate j)
shield at Magmeter

Instrument

Earth ground

4in.to 50 in. 4in. to 50 in.
>
(10 cmto 1.3 m) (10 cmto 1.3 m)

Grounding rings on plastic pipe
@ (Install between flanges) @
or
metal straps on metal pipe

12.2 Maintenance
The 2551 Magmeter requires very little maintenance. There are no user-serviceable components in the magmeter.

« If the fluid contains deposits and solids that may coat the electrodes, a regular cleaning regimen is recommended.
» Do not use abrasive materials on the metal electrodes. Clean with soft cloth and mild detergent only.
*  Use a cotton swab and mild detergent to remove deposits on the metal electrodes.

Environmental Recommendations:
*  When used properly, this product presents no inherent danger to the environment.
»  Please follow local ordinance when disposing of this or any product with electronic components.
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12.3 Troubleshooting

Symptom

Possible Cause

Solution

QOutput is erratic and unstable.

Magmeter installed too close to
upstream obstruction.

Magmeter located in area exposed to
air bubbles/pockets.

Magmeter is installed in pipe
backwards.

Electrical noise is interfering with the
measurement.

Electrodes are coated with deposits
or chemical oxide layers.

Relocate the magmeter to have
straight uninterrupted pipe upstream
of the sensor for at least 10 x the pipe
diameter.

Eliminate air bubbles in the pipe.
Remove the magmeter and reinstall
with the flow direction arrow on the
sensor body pointed DOWNSTREAM.
Review the grounding of the
magmeter and the pipe. Install
adequate Earth ground to allow the
magmeter to operate properly.

Output is not 0 when flow is stopped.

Electrodes not adequately conditioned
in fluid.
Fluid is moving inside the pipe.

Allow the sensor to sit in full pipe for
24 hours then restart.

Increase the Low Flow Cutoff.
(section 7.0)

No 4-20 mA output.

Loop power not connected correctly.

Connect 24 VDC +£10% connected to
loop terminals 1 and 3.

4-20 mA current output is incorrect.

4-20 mA is not scaled properly.

Check and reset in the Setup Menu.

No Frequency output.
No S3L output.

2551 is wrong model.
Incorrect setting in Options Menu.

Wiring is not correct.

Frequency input to other
manufacturer's flow instrument does
not have pull-up resistor.

Frequency/S3L model:

3-2551-21 (w/rlys)or -41 (w/o rlys)
Select Frequency in the Options
menu.

Check wiring, make corrections.
Install 10kQ2 resistor. (section 5.1)

No flow rate, current output is 22 mA.

The fluid is too clean for magmeter.

Electronic component failure.

Unsuitable application for magmeter.

Return 2551 to factory.

Blank display, no backlighting, no
relay LEDS, but external equipment
using output signal is still working.

2551 AUX power is not connected.

Connect AUX power (section 5.5)
(9to 24 VDC, 0.4 Amax.)

Error Message:

Main power is below specification

Correct the main power deficiency

"Error Not Saved"

Troubleshooting with the RED and BLUE lights Reverse flow:

No Lights: +  Frequency out cannot distinguish reverse flow from forward
The power is off or the sensor is not connected flow. The output will be the absolute value.

Solid Blue: . Digital (S°L) output: Reverse flow results in 0 flow rate

The power is on but there is no flow in the pipe. displayed on 8900

Blinking Blue: +  4-20 mA output can be spanned into negative flow range

using the custom setup tool. (example: 4-20 mA = -100 to
+100 GPM)

Normal operation, blink rate is
proportional to the flow rate.
Alternating Red-Blue:

Empty pipe indication (electrodes

Empty Pipe Detection
are not wet.) °

Frequency output will be locked to 0 Hz if electrodes are not

Blinking Red: wet.

System errors (Electrical noise . Digital (S°L) output will be locked to 0 if electrodes are not
interference) wet.

Solid Red: e 4-20 mA will be locked to 4 mA if electrodes are not wet.

* Blue and Red LED indicators on the magmeter circuit will

Instrument error (defective
blink alternately if the electrodes are not wet.

electronic component)
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13.0 Ordering Information

Sensor Part No.

3-2551

Sensor Body (Transducer) and electrodes/grounding ring materials - Choose one

-P | Polypropylene and 316L SS

-T | PVDF and Titanium

-V | PVDF and Hastelloy C

-W | PVDF and 316L SS

Pipe size - Choose one

0 |DN15to DN100 (1/2to 4 in.)

1 | DN125 to DN200 (5 to 8 in.)

2 | DN250 to DN300 (10 to 12in.)

Di

splay Options - Choose One

-2 | With Display, two SPDT relays, one solid state relay

-4 [ With Display, no relays

Qutput options - Choose One

1

Open Collector Frequency out or Digital (S3L) out

2 |4 to 20 mA output

3-2551 [-P |0 [-2 [2 |Example Part Number
Mfr. Part Number Code Mfr. Part Number Code
3-2551-P0-21 159 001 267 3-2551-V0-21 159 001 269
3-2551-P0-22 159 001 273 3-2551-V0-22 159 001 275
3-2551-P0-41 159 001 261 3-2551-V0-41 159 001 263
3-2551-P0-42 159 001 279 3-2551-V0-42 159 001 281
3-2551-P1-21 159 001 268 3-2551-V1-21 159 001 270
3-2551-P1-22 159 001 274 3-2551-V1-22 159 001 276
3-2551-P1-41 159 001 262 3-2551-V1-41 159 001 264
3-2551-P1-42 159 001 280 3-2551-V1-42 159 001 282
3-2551-P2-21 159 001 435 3-2551-V2-21 159 001 456
3-2551-P2-22 159 001 438 3-2551-V2-22 159 001 457
3-2551-P2-41 159 001 432 3-2551-V2-41 159 001 462
3-2551-P2-42 159 001 441 3-2551-V2-42 159 001 463
3-2551-T0-21 159 001 436 3-2551-W0-21 159 001 271
3-2551-T0-22 159 001 439 3-2551-W0-22 159 001 277
3-2551-T0-41 159 001 433 3-2551-W0-41 159 001 265
3-2551-T0-42 159 001 442 3-2551-W0-42 159 001 283
3-2551-T1-21 159 001 437 3-2551-W1-21 159 001 272
3-2551-T1-22 159 001 440 3-2551-W1-22 159 001 278
3-2551-T1-41 159 001 434 3-2551-W1-41 159 001 266
3-2551-T1-42 159 001 443 3-2551-W1-42 159 001 284
3-2551-T2-21 159 001 454 3-2551-W2-21 159 001 458
3-2551-T2-22 159 001 455 3-2551-W2-22 159 001 459
3-2551-T2-41 159 001 460 3-2551-W2-41 159 001 464
3-2551-T2-42 159 001 461 3-2551-W2-42 159 001 465

Replacement parts

Mfr. Part No. Code Description

1220-0021 198 801 186 O-ring, FPM (Viton®)

1224-0021 198 820 006 O-ring, EPDM

1228-0021 198 820 007 O-ring, FFPM (Kalrez®)

3-8551.521 159 001 378 Clear plastic cap for display

3-8050.396 159 000 617 RC Filter kit (for relay protection)
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